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WINDOWS REGISTRY EDITS 

Warning & Disclaimer 

 It is strongly recommended that you do not edit registry settings 

yourself until you have skill and proficiency to do so. 

 Incorrectly editing the registry may severely damage your 

system. At the very least, you should back up any valued data 
on the computer before making changes to the registry.  

 You can also create a system restore point before making 
changes in the registry or trying the tips. 

 You may need to have an administrator account on your 
computer to make changes to the registry.  

 You can only back up the System State data on a local computer 
and not on a remote computer.  

 

Although all registry tips in this section are collected from trusted sources 
and personally tested however the author do not held responsible for any 

inconvenience and any damage that may unintentionally be caused 

through their use. Use these tips at your own risk.  

ABOUT REGISTRY 
The Windows XP registry is the database in which the operating system 

stores most of its settings. It contains profiles for each user of the 
computer and information about system hardware, installed programs, 

and property settings. Importantly, the registry defines relationships 

between different parts of the operating system's user interface. For 
example, the registry defines what you see on the desktop; how the Start 

menu and taskbar work; and how the operating system starts. Windows 
continually references this information during its operation. 

Registry editors are available that enable you to inspect and modify the 
registry. However, you should not need to do so. Instead, allow Windows 
programs to modify the system registry as needed. If you do damage 

your system, you may be able to repair the registry or restore it to the 
same version you were using when you last successfully started your 

computer. Otherwise, you must reinstall Windows. When you reinstall 

your system, you may lose any changes that have been made, such as 
Service Pack upgrades, which you must reinstall separately.  

Making Changes to the Registry 
You can change registry settings to customize how the operating system 

looks and feels. Many settings can't be changed by using a Windows XP 
user interface, such as a dialog box. Instead, you must change them in 

the registry. The registry editor that ships with Windows is regedit.exe.  

HOW TO BACKUP REGISTRY 
This step-by-step article describes how to back up, edit, and restore the 
registry in Windows XP. Microsoft recommends that before you edit the 
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registry, you back up the registry and understand how to restore it if a 

problem occurs. Before you edit the registry, export the keys in the 
registry that you plan to edit, or back up the whole registry. If a problem 

occurs, you can then restore the registry to its previous state. 

How to Export Registry Keys 
You can follow these steps to export a single registry key as backup 
before you edit it. Do not follow these steps to export a whole registry 

hive (for example, the HKEY_CURRENT_USER hive). If you must back 
up whole registry hives, back up the whole registry instead.  

1. Click Start, and then click Run.  
2. In the Open box, type regedit, and then click OK.  

3. Locate and then click the key that contains the value that you 
plan to edit.  

4. On the File menu, click Export.  
5. In the Export Range section, make sure 'All' is selected 

6. Type 'RegBackup' in the File Name field 
7. In the Save in box, select a location in which to save the .reg file. 

In the File name box, type a file name, and then click Save. 

How to Back Up the Whole Registry 
To back up the whole registry, use the Backup utility to back up the 

System State (which includes the registry, the COM+ Class Registration 
Database, and your boot files). Backup Utility for Windows (included with 

Windows XP) is a tool to back up files and folders on your computer. It 
helps you to protect your data in case your hard disk fails or files are 

accidentally erased. By using Backup, you can create a duplicate copy of 
all of the data on your hard disk and then archive it on another storage 

device, such as a hard disk or a tape. 
 

If the original data on your hard disk is accidentally erased or overwritten, 
or becomes inaccessible because of a hard-disk malfunction, you can 

easily restore the data from the disk or archived copy by using the 
Restore Wizard or Automated System Recovery Wizard. 

How to Back Up Files and Folders 

1. Click Start, point to All Programs, point to Accessories, 

point to System Tools, and then click Backup. The 
Backup or Restore Wizard starts.  

2. Click Advanced Mode and then Backup tab.  

3. On the Job menu, click New.  

4. Select the check boxes for the drives that you want to back up. If 
you want to be more specific in your selections, expand the drive, 

and click the check boxes for the files or folders that you want.  

5. Select the System State check box. 

6. In the Backup destination list, click the backup destination that 
you want to use.  

7. If you clicked File in the previous step, type the full path and file 

name that you want in the Backup media or file name box. Note 
that you can also specify a network share as a destination for the 

backup file.  
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8. Click Start Backup. The Backup Job Information dialog box 

appears.  
9. Under If the media already contains backups, use one of the 

following steps:  

o If you want to append this backup to previous backups, click 
Append this backup to the media.  

o If you want to overwrite previous backups with this backup, 
click Replace the data on the media with this backup. 

10. Click Advanced.  
11. Select the Verify data after backup check box.  

12. In the Backup Type box, click the type of backup that you want. 

When you click a backup type, a description of that backup type is 
displayed under "Description."  

13. Click OK, and then click Start Backup. A Backup Progress dialog 

box appears, and the backup starts.  

14. When the backup is complete, click Close. 

How to Edit the Registry 
To edit the registry, Microsoft recommends that you follow the steps in 
the Microsoft documentation only. If possible, use the Windows user 

interface instead of directly editing the registry. Using Registry Editor 
incorrectly can cause serious problems that may require that you reinstall 

your operating system. Microsoft cannot guarantee that problems that 
result from incorrectly using Registry Editor can be solved. Use Registry 

Editor at your own risk. For more information about editing the registry, 
follow these steps in Registry Editor:  

1. On the Help menu, click Help Topics.  

2. On the Contents tab, double-click Registry Editor.  

3. Double-click How To.  

4. Double-click Change Keys and Values, and then click the 
topic that you want. 

HOW TO RESTORE THE REGISTRY 
This article is a step-by-step guide to using the Backup program in 

Windows XP to restore files and folders on your computer. If the original 
data on your hard disk is accidentally erased or overwritten, or becomes 

inaccessible because of a hard-disk malfunction, you can easily restore it 
from the disk or archived copy by using the Restore Wizard or Automated 

System Recovery Wizard. 

How to Restore Registry Keys 
To restore registry keys that you have already exported as backup files, 
double-click the .reg file that you saved. It will overwrite the registry and 

restore registry keys in the state before editing. 

How to Restore Files and Folders 

1. Click Start, point to All Programs, point to Accessories, point to 

System Tools, and then click Backup. The Backup or Restore 
Wizard starts.  
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2. Click Advanced Mode.  

3. Click the Restore and Manage Media tab.  

4. Use the following step:  

o If you want to restore from a backup file, expand File, and 
then expand the backup file that you want. For example, 

expand Backup.bkf created 01/01/2002 at 4:15 PM. 
Backup includes the date and time of the backup as part of 

the file name by default.  

5. Select the check boxes for the folders that you want to restore. If 

you want to be more specific in your selections, double-click the 
folder that you want, and then select the check boxes for the files 

or folders that you want to restore.  

6. If you are restoring the entire operating system, select the 
System State check box. 

Note: If you want to restore the operating system as well as your 
data files, you should restore the System State data, which 

includes such things as the registry, the COM+ class registration 
database, files under Windows File Protection, and boot files.  

7. In the Restore files to box, use one of the following steps:  

o Click Original location if you want to restore the files to the 

location from which you backed them up. Use this selection 
when you restore the entire computer.  

o Click Alternate location if you want to restore a file or files 
to another location on the hard disk. Type the location that 

you want in the Alternate location box. Use this selection to 
prevent the restore operation from overwriting existing files 

on your computer.  

o Click Single folder if you want to restore a file or files to a 

single folder on the hard disk. Type the location that you want 
in the Alternate location box. Use this selection to separate 

the restored files or folders from the rest of the files on the 
hard disk. 

8. On the Tools menu, click Options.  

9. Click the method that you want Backup to use when it restores a 
file that is already on the computer, and then click OK. Backup 

uses this selection to determine whether to overwrite an existing 
file, when it restores a file in a folder that contains the existing file. 

Note: If you are restoring the operating system, click Always 

replace the file on my computer.  

10. Click Start Restore.  

11. If the following message appears, click OK if you want to restore 
the System State information with the selected backup:  

12. In the Confirm Restore prompt that appears, click OK. A 

Restore Progress dialog box appears, and the restore operation 
starts.  
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13. When the restore process is complete, click Close. If you are 

prompted to restart the computer, click Yes. 

ABOUT SCRIPTS 
You can edit the registry manually, using the Registry Editor 
(Regedit.exe), or you can use scripts instead, which is the method that 

often computer users particularly beginners prefer because they're 
quicker to use than Regedit and they're more safe and testable. After 

verifying that a script works, you can use it repeatedly without worrying.  

Here we are showing you a few of the most favorite registry hacks for 
beginners and advanced users. Advanced users already know their way 

around Regedit and can edit these settings directly, using the Registry 
Editor. Although even advanced users should be aware that if they use 

Registry Editor incorrectly, they can cause serious problems that may 

require them to reinstall their operating systems. Beginners should use 
the listings, which automatically change the registry for them. 

Using Scripts to edit the Registry 
Here, we are helping you to create scripts, which are listings that you 

write into Notepad that automatically make changes to the registry. 

Note:  When using Notepad to create the listings provided below, 
Notepad adds the .txt extension to files by default. For example, if 

you type Sample.reg in the Save As dialog box, Notepad saves the 
file as Sample.reg.txt. This is not helpful, because you cannot 

import the file by double-clicking it.  

Important: There are two ways to force Notepad to save the file 

using the .reg extension. The first is to enclose the entire file name 
in quotation marks. The second is to click All Files in the Save as 

type list. Either way, make sure the file has the .reg extension. 

How to create a registry script? 

1. Copy the text in the listing to Notepad, being careful to copy all the 
text exactly in the same manner.  

2. Save the file using the .reg extension.  
3. Double-click the file to import it into the registry.  

4. Click Yes in the message box, and another message box tells you if 
you have successfully entered the information in the registry.  

Hiding the Recycle Bin 
How do you remove the Recycle Bin icon from the desktop? Microsoft 

removed the other icons from the desktop but not the Recycle Bin icon 
because emptying the trash would not be as easy without it.  

Listing 1 hides the Recycle Bin. There are different ways to hide the icon, 
but this is the best method. It hides the Recycle Bin icon whether you are 

using the classic or new Start menu. Use Notepad to create a text file 
called Hidebin.reg.  
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REGEDIT4 

 

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\E

xplorer\HideDesktopIcons] 

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\E

xplorer\HideDesktopIcons\ClassicStartMenu] 

"{645FF040-5081-101B-9F08-00AA002F954E}"=dword:00000001 

 

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\E

xplorer\HideDesktopIcons\NewStartPanel] 

"{645FF040-5081-101B-9F08-00AA002F954E}"=dword:00000001 

Listing 2 If you miss the Recycle Bin icon and want to show it again, 
create the text file Showbin.reg and copy Listing 2 in to it. Double-click 

Showbin.reg to restore the Recycle Bin icon to the desktop. 

REGEDIT4 

 

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\E

xplorer\HideDesktopIcons] 

 

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\E

xplorer\HideDesktopIcons\ClassicStartMenu] 

"{645FF040-5081-101B-9F08-00AA002F954E}"=dword:00000000 

 

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\E

xplorer\HideDesktopIcons\NewStartPanel] 

"{645FF040-5081-101B-9F08-00AA002F954E}"=dword:00000000 

Both listings require you to refresh the desktop in order to see your 
changes. To do that, click anywhere on the desktop, and then press F5. 

Add Recycle Bin to Folder Options 
Listings 1 and 2 above are the direct way to hide the Recycle Bin icon. To 
demonstrate one of the cooler ways to hack the Windows XP registry, we 

show you a better way to hide the icon. We'll give it a user interface. 

Listing 3 does just that. It extends Folder Options by adding an option 
for showing the Recycle Bin icon on the desktop. Customizing the key 
HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\Advanced\

Folder is how you add options to this dialog box. Advanced users can use 
this key as a guide for how to extend it.  

Beginners can use this script to add an option for the Recycle Bin icon: 
Save Listing 3 below in the text file Binopt.reg and then double-click it. 

After importing Binopt.reg into the registry, a new option is listed in the 
Folder Options dialog box that lets you configure the Recycle Bin icon. 

To hide or show the Recycle Bin icon using Folder Options: 

1. In Windows Explorer, on the Tools menu, click Folder Options.  

2. On the View tab, under Advanced Settings, do one of the 
following: 
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 Select the Show Recycle Bin icon on the desktop check box to 

show the icon on your desktop.  

 Clear the Show Recycle Bin icon on the desktop check box to 

remove the icon from your desktop.  

REGEDIT4 

 

[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\

Explorer\Advanced\Folder\RecycleBinOnDesktop] 

"RegPath"="Software\\Microsoft\\Windows\\CurrentVersion\\Explo

rer\\HideDesktopIcons\\NewStartPanel" 

"Text"="Show Recycle Bin icon on the desktop" 

"Type"="checkbox" 

"ValueName"="{645FF040-5081-101B-9F08-00AA002F954E}" 

"CheckedValue"=dword:00000000 

"UncheckedValue"=dword:00000001 

"DefaultValue"=dword:00000001 

"HKeyRoot"=dword:80000001 

Clear History Lists 

Ever wondered how to get rid of the different history lists that Windows 

XP keeps? The operating system keeps track of the programs you run 
using the Run dialog box, the documents you have opened, and the files 

for which you have searched. Sometimes clearing these lists is useful, 
particularly if you share an account with other users and want to prevent 

prying eyes from seeing what you have been doing. 

Listing 4 removes the most common history lists from the registry. Save 

it as the text file Cleanmru.reg and double-click to remove these lists. 

REGEDIT4 

 

[-HKEY_CURRENT_USER\Software\Microsoft\Internet 

Explorer\TypedURLs] 

 

[-

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Ex

plorer\RunMRU] 

 

[-

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Ex

plorer\RecentDocs] 

[-

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Ex

plorer\ComDlg32\LastVisitedMRU] 

[-HKEY_CURRENT_USER\Software\Microsoft\Search Assistant\ACMru] 

Rename the My Computer Icon 
If you show the My Computer icon on your desktop, you should customize 

it. First, you can rename the icon to make it more personal. Would not 
you rather see Ajmal's Computer instead of My Computer, assuming your 

name is Ajmal? 
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You can right-click the My Computer icon to rename it. There's a better 

way, though, and that's to change the name in the registry and include an 
environment variable in the name. Environment variables are strings that 

contain information about the environment for the system and the 
currently logged on user. Using the environment variable %USERNAME% 

in the name of the My Computer icon will automatically change the 
icon's name for every user who uses the computer. (If you want to see 

what other environment variables are available, type set at the command 
prompt, and press Enter.) 

Listing 5 sets the name of the My Computer icon to %USERNAME%'s 

Computer. Windows XP substitutes your account name for 

%USERNAME%. Incidentally, this also changes the name of the My 
Computer icon on the Start menu. Create the text file Mycomp.reg, and 

then double-click the file. 

REGEDIT4 

 

[HKEY_CLASSES_ROOT\CLSID\{20D04FE0-3AEA-1069-A2D8-

08002B30309D}] 

"LocalizedString"=hex(2):25,55,53,45,52,4e,41,4d,45,25,27,73,2

0,43,6f,6d,70,75,74,65,72,00 

Change My Computer Title to your Name 

1. Start Regedit 

2. HKEY_CLASSES_ROOT\CLSID\{20D04FE0-3AEA-1069-A2D8-
08002B30309D} » LocalizedString  

3. Value data:  To change to user name: Delete value name (Default) 
in key 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion
\Explorer\CLSID\{20D04FE0-3AEA-1069-A2D8-08002B30309D}, 

then set value data of value name above in key above to your name 

i.e [AJMAL BEIG}, requires refresh desktop.  
4. To undo, change value data of value name above in key above to 

@%SYSTEMROOT%\System32\shell32.dll,-9216, refresh desktop.  

Change Recycle Bin Title  

1. Start Regedit 
2. HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion

\Explorer\CLSID\{645FF040-5081-101B-9F08-00AA002F954E} » 
(Default) » [WASTE BASKET], requires refresh desktop. 

3. To undo, delete value name above in key above, then refresh 
desktop. 

Add a Rename Option to the Recycle Bin Context Menu 
To add the "Rename" option to the Recycle Bin when right-clicking on it, 

open Notepad and copy these lines into it: 
 

[HKEY_CLASSES_ROOT\CLSID\{654FF040-5081-101B-9F08-
00AA002F954E}\ShellFolder] 

"Attributes"=hex50,01,00,20 
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Name the file 'BIN.REG' then double-click on it to add it to the registry. 

You can now right-click on the Recycle Bin and rename it to whatever you 
would like. 

WINDOWS XP REGISTRY EDITING & TWEAKS 
You may need to have an administrator account on your computer to 

make changes to the registry. Incorrectly editing the registry may 
severely damage your system. At the very least, you should back up 

any valued data on the computer before making changes to the registry. 

Make Risky File Extensions Obvious 
Having file extensions visible can make certain malicious programs in your 
e-mail inbox more obvious. For example, showing a file attachment such 

as picture.jpg.exe, this would otherwise have the harmless-looking name 
picture.jpg. On the other hand, displaying all file extensions all the time 

looks ugly; makes file names more difficult to read. With a little editing of 
the Windows Registry, you can make Windows display only the file 

extensions of executable files, which you're less likely to rename or 
interact with directly. Follow these steps: 

1. Click on the Start button and select Run 
2. Type in 'regedit' and press OK  

3. Double-click on the 'HKEY_CLASSES_ROOT' key 

4. Scroll down the list to the 'Exefile' key (press Ctrl+F and type file 
name to locate it)  

5. Right-click in the right pane and select 'New->String Value' 
6. Type in 'AlwaysShowExt' and press OK 

You may need to restart Windows to see the effect, but from now on, all 

application files will have their .exe extensions visible in folder windows 
and other programs that display file names, even when 'Hide extensions 

for known file types' in Folder Option > View is selected.  

Shortcuts without the "Shortcut To" 
To stop windows from adding the 'Shortcut To' text to newly created 
shortcuts on the Desktop, follow these steps: 

1. Click on the Start button and select Run 
2. Type in 'regedit' and click OK 

3. Look for this key 

HKEY_USERS\Default\Software\Microsoft\Windows\CurrentVersion\
Explorer 

4. Right-click in the right pane and select 'New->Binary Value' 
5. Enter '00,00,00,00' and click OK 

Power Off at Shutdown 
If your computer does not turn off the power when doing a shutdown, you 

may need to edit the registry. If you have all the correct BIOS and Power 
settings and still needed to do this, follow these steps: 

1. Start Regedit 
2. Go to HKEY_CURRENT_USER\Control Panel\Desktop 

3. Edit the key PowerOffActive and give it a value of 1 
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4. You can do the same in HKEY_USERS\.DEFAULT\Control 

Panel\Desktop 

Teach your PC to Shut Down rapidly? 
For both Home and Professional edition users go to Start->Run and type 
“regedit” to fire up the Registry Editor. Navigate to the following key: 

HKLM\SYSTEM\CurrentControlSet\Control\SessionManager\Mem
ory Management and set the “ClearPageFileAtShutdown” value to 0. (XP 

Professional users can do this via the Group Policy Editor. To start it, go to 
Start>Run and type “secpol.msc”. Click Local Policies, then Security 

Options, and set “Shutdown: Clear virtual memory page file” to 
Disabled.) 

Auto Reboot Windows XP 
When a system fault, error, or crash ends up freezing your operating 

system, you can bypass doing a complete reboot by following these steps: 

1. Open Notepad and copy the lines below into it 

2. Save and name the file 'AutoReboot.reg' 
3. Double-click on the newly created file and select 'Yes' 

4. Reboot your computer for the changes to take effect 
5. HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\CrashC

ontrol"AutoReboot"="1" 

Taskbar Tray Text (Windows 98/Me/XP) 
You can put your name or any other text into the Taskbar next to the 
Time/Date. To do this, go to Registry and look for this string: 

HKEY_CURRENT_USER\Control Panel\International 

1. Right-click in the right pane and select 'New>String Value', name 
it 's1159', then right-click on the new string and select 'Modify', 

type in the text you want for the Taskbar.  
2. Now right-click in the right pane again and select 'New>String 

Value' and name it 's2359'. Double-click on it and type in the 
same text.  

3. Restart you computer and the text should now be in the Taskbar. 
(In XP both of these string values already exist, simply add your 

text). 

Start Windows Explorer in the location of your choice 
By default, when you access Windows Explorer it will go directly to the My 
Documents folder. To change this, right click on the icon and replace the 

Target field with: “%SystemRoot%explorer.exe /e, c:”. You can 
make it start in any other location. For example, you can instruct it to 

start directly on My Computer by adding this string: 
“%SystemRoot%explorer.exe /e,”. 

Create your Own Logon Message   
You can create a message that will appear when you log on to your 

computer. Here is how: 

1. Click Start, click Run, type regedit, and then click OK.  
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2. In the Registry Editor, drill down to the following key: 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\WindowsNT\ 
CurrentVersion\Winlogon  

3. Right-click LegalNoticeCaption, click Modify, type My Windows XP 
Machine, and then click OK.  

4. Right-click LegalNoticeText, click Modify, and then type your 
message.  

5. Close the editor and your new message will appear at every log on.  

This tip applies to computers that are part of a domain. For stand-alone or 
peer-to-peer networks, the custom screen appears just before the 

Welcome screen. 

Logging in as Administrator 
If you want to log in as Administrator, but it is not show on the Welcome 

screen, follow these steps: 

1. Hold the Ctrl-Alt key and press Del twice.  

2. This will bring up the normal login and you can log on as 
Administrator  

To unhide the Administrator account  

1. Start Regedit  

2. Go to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Winlogon\SpecialAccounts\UserList  

3. Unhide the Administrator key by giving it a value of 1 

Changing the Registered Owner 

1. Start Regedit  
2. HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 

NT\CurrentVersion  
3. From there you can edit the name in the Registered Owner key 

Changing the Login Screen Saver 
If you want to change the screen saver that runs at the login prompt: 

1. Start Regedit 
2. Go to HK_USERS / .DEFAULT / Control Panel / Desktop  

3. Double click on SCRNSAVE.EXE  
4. Enter in the screen saver you want to use  

Hide/Unhide Logon Names 
If you want to hide or unhide the names of users that are displayed on 

the initial logon screen, do the following: 

1. Start Regedit  

2. Go to    

3. Add a DWORD with the name of the user account you want to hide  
4. Make sure it has a value of 0  

5. If there is an existing account, unhide it by giving it a value of 1 
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Hiding the Windows Version on the Desktop 
If your version of WindowsXP is displaying on the desktop and you would 
like to remove it, do the following: 

1. Start Regedit  
2. Go to HKEY_CURRENT_USER \ Control Panel \ Desktop  

3. Edit or Create the DWORD entry PaintDesktopVersion  
4. A value of 0 will hide the version from the desktop.   

5. Logoff or reboot  

To make this change for all future users, edit 
HKEY_USERS\.DEFAULT\Control Panel\Desktop in the same manner. 

Clearing the Page File on Shutdown 
To set the computer to clear the pagefile on each shutdown: 

1. Start Regedit  
2. Go to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\ 

Session Manager\Memory Management\ClearPageFileAtShutdown  
3. Set the value to 1  

Restoring Access to CD ROMs 
If after you remove CD Burning software, you can no longer access your 

CD ROM's, the following registry keys need to be deleted: 
 

Locate and delete the UpperFilters and LowerFilters values under the 
following key in the registry: 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Class\ 
{4D36E965-E325-11CE-BFC1-08002BE10318}  

Set the Online Registration as Being Completed 
You can set Windows XP to assume the online registration has been 

completed. Here is how: 

1. Run Regedit  

2. Go to HKEY_LOCAL_MACHINE \ SOFTWARE \ Microsoft \  
Windows NT \ CurrentVersion  

3. Create a String Value called RegDone  

4. Give it a value of 1  

Command Line Help Reference 
To get a quick help for all the commands you can enter from Windows XP, 
simply create a shortcut: 

hh.exe ms-its:C:\WINDOWS\Help\ntcmds.chm::/ntcmds.htm 

Increasing System Performance 
If you have 512 megabytes or more of memory, you can increase system 
performance by having the core system kept in memory. 

1. Start Regedit  
2. Go to 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session 
Manager\Memory Management\DisablePagingExecutive  

3. Set the value to be 1  
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4. Reboot the computer  

Increasing File System Caching 
To increase the amount of memory Windows will locked for I/O 

(input/output) operations: 

1. Start Regedit  

2. Go to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\ 
Control\Session Manager\Memory Management  

3. Edit the key IoPageLockLimit  
4096 - 32megs of memory or less 

8192 - 32+ megs of memory 
16384 - 64+ megs of memory 

32768 - 128+ megs of memory 
65536 - 256+ megs of memory 

Removing Unread Email Messages 
To remove Unread Email message by user's login names: 

1. Start Regedit  
2. For a single user: Go to 

HKEY_CURRENT_USER\Software\Microsoft\Windows\ 
CurrentVersion\UnreadMail  

3. For all users: Go to 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\ 
CurrentVersion\UnreadMail  

4. Create a DWORD key called MessageExpiryDays  
5. Give it a value of 0  

Removing the MSN Messenger 
If you want to remove the MSN Messenger from always starting in the 

system tray, follow these steps: 

1. Start / Run , enter in the following string:  

RunDll32 advpack.dll,LaunchINFSection 
%windir%\INF\msmsgs.inf,BLC.Remove  

To remove the hide from the line:  
msmsgs=msgrocm.dll,OcEntry,msmsgs.inf,hide,7 

Enabling NumLock on by Default 
To have numlock turned on for each user, follow these steps: 

1. Start Regedit and go to  
HKEY_CURRENT_USER\ControlPanel\Keyboard\InitialKeyboardIndic

ators  
2. Change the value from 0 to 2  

3. Turn Numlock on manually  
4. Log off and back on again.  

5. For all users, make the same change to 

HKEY_USERS\.DEFAULT\Control Panel\Keyboard\ 
InitialKeyboardIndicators 
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Enable Windows to handle with zip archives 
Go to Start>Run and type “REGSVR32 ZIPFLDR.DLL” or “cmd /c 
assoc .zip=CompressedFolder”. Press Enter. 

Disable Status Messages during Boot, Logon/Shutdown 
1. Start/Run/Regedit 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVers
ion\Policies\System 

2. Right click in the right pane and select New, DWord value.  
3. Name the new value DisableStatusMessages.  

4. Double click the new value and set it to 1.  

5. Status messages will no longer show during 
boot/shutdown/logon/logoff.  

Disable Tool Tips 
1. Start/Run/Regedit  

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersio
n\Explorer\Advanced.   

2. Modify or create, "ShowInfoTip" and set the Value to 0. 
3. To restore set the Value to 1.  

4. This edit excludes the Start Button.  

Disable Balloon Tips 
1. Start/Run/Regedit  

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersio

n\Explorer\Advanced.   
2. Modify or create, "EnableBalloonTips" and set the Value to 0.  

3. To restore set the Value to 1. 

Disable Error Reporting 
1. Start/Run/Regedit  

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\PCHealth\ErrorReporting.  

4. Value: DoReport, 1 = Send Reports, 0 = Don't Send.  

Disable Error Messages When Booting  
1. Start/Run/Regedit  

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Windows. 

2. Value Name: NoPopupsOnBoot,  
3. Data Type: REG_DWORD (DWORD Value),  

4. Value Data: (1 = disable messages). Stops the annoying Windows 

pop-up messages notifying you a device is not functioning when you 
boot-up Windows.  

5. Create a REG_DWORD value of 'NoPopupsOnBoot' in the key below 
(if it doesn't already exist).  

6. Set the value to '1' to disable pop-up messages from appearing. 

Disable System Beeps 
1. Start/Run/Regedit 

HKEY_CURRENT_USER\Control Panel\Sound  

2. In the right pane, right click "Beeps",  
3. Modify, set the value to no. Exit, reboot.  
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Disable Windows Default Image Viewer 
If the Windows Picture and Fax Viewer is set as the default for many of 
your graphic file types, you can remove it so other graphics programs can 

be used instead. 

1. Run Regedit  

2. Go to HKEY_CLASSES_ROOT / SystemFileAssociations /  
image / ShellEx / ContextMenuHandlers  

3. Delete the key ShellImagePreview  

Disable the Logon Screen Saver from Launching 
1. Start/Run/Regedit 

HKEY_USERS\.DEFAULT\Control Panel\Desktop.  
2. Value Name: ScreenSaveActive,  

3. Data Type: REG_SZ (String Value),  
4. Value Data: (0 = disabled, 1 =enabled).  

5. Change the value of 'ScreenSaveActive' to '0' to disable the screen 
saver. 

6. Restart Windows for the change to take effect.  
 

Note: Windows has a default screen saver called login.scr, which 

runs even if no screen saver has been selected.  

Disable Low Disk Space Message 
1. Start/Run/Regedit  

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersi

on\Policies\Explorer.   
2. Create or modify: NoLowDiskSpaceChecks REG_DWORD and set the 

value to 1. Logoff/Reboot.  

Disable Thumbnail Cache 
1. Start/Run/Regedit 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion
\ Explorer\Advanced.  

2. Value Name: DisableThumbnailCache,  
3. Data Type: REG_DWORD (DWORD Value),  

4. Value Data: (0 = enabled, 1 = disable cache).  
5. Create a new DWORD value, or modify the existing value, called 

'DisableThumbnailCache' and edit the value according to the 
settings.  

6. Exit your registry, restart or log out to take effect.  

Disable Windows Balloon Tips 

1. Start Regedit  
2. Go to HKEY_CURRENT_USER\Software\Microsoft\Windows\ 

CurrentVersion\Explorer\Advanced\  
3. Create a DWORD value of EnableBalloonTips, give it a value of 0  

Remove My Documents from the Desktop  
1. Start/Run/Regedit  



TIPS & TRICKS WINDOWS XP REGISTRY EDITS P a g e  | 19 

2. HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion

\Explorer\CLSID\{450D8FBA-AD25-11D0-98A8-
0800361B1103}\ShellFolder  

3. Value Name: Attributes  
4. Data Type: REG_DWORD (DWORD Value)  

5. Value Data: (0xf0500174 = Hidden, 0xf0400174 = Default)  
6. Modify the value called "Attributes" and set it to either 

"0xf0500174" to hide or "0xf0400174" to display My Documents. 

Note: Click on a blank area of desktop and press F5 to refresh for 

the change to take effect.  

Remove Frequent Programs List from the Start Menu 
1. Start/Run/Regedit 

You may need to create the key if it does not already exist. Create a 

new DWORD value, or modify the existing value, called 
'NoStartMenuMFUprogramsList' and edit the value according to 

the settings below. 
2. HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion

\Policies\Explorer 

HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersio
n\ Policies\Explorer  

3. Value Name: NoStartMenuMFUprogramsList  
4. Data Type: REG_DWORD (DWORD Value)  

5. Value Data: (0 = default, 1 = enable restriction).   
 

Note: This setting only applies to the Windows XP Start Menu, not 
the Classic Start Menu. Exit your registry, you may need to restart 

or log out of Windows for the change to take effect.  

Remove Username & Picture from Windows XP Start 
Menu 
The Windows XP start menu displays your username and a picture at the 
top. Many complain that they don’t want this information to be shown but 

there is no solution for this. Well, there is, of course without disabling the 
Welcome Screen and Windows XP Themes. Go to C:Documents and 

Settings\All Users\Application Data\Microsoft\User 
Account\Pictures. Inside the folder there is a BMP picture file named 

after your username. If your name is Smith then the picture file should be 
named Smith.bmp. Rename it to Smith2.bmp, then rename the following 

folder: C:Documents and Settings\All Users\Application 
Data\Microsoft\User Account\ Pictures\Default Pictures to “Old_Default 

Pictures”.  

To remove the user name, go to the “regedit” and look for 

HKEY_CURRENT_USERSoftwareMicrosoft 
WindowsCurrentVersionPoliciesExplorer. In the right panel, set the 

“NoUserNameInStartMenu” value to 1. After a system reboot, no 
username or picture will be shown. 
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COSMETIC EDITS FOR WINDOWS XP 

Change the Text in Internet Explorers Title Bar 
1. Start/Run/Regedit  

2. HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Main.  
3. In the right pane, change the value of the string, "WindowTitle".  

Change the Title of Windows Media Player 
1. Start/Run/Regedit  

HKEY_CURRENT_USER\Software\Policies\Microsoft\ 
WindowsMediaPlayer.  

2. Value Name: TitleBar,  
3. Data Type: REG_SZ (String Value).  

4. Create a new string value called "TitleBar" and set it to the text you 
would like display in the title.  

5. Restart Media Player for the change the take effect.  

Change Name & Company Info after Installation  
1. Start/Run/Regedit 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion  

2. In the right pane, double-click RegisteredOrganization.  
3. Under "Value data", type the name that you want, and then click 

OK.  
4. To change the name of the registered owner, do the following:  

5. In the right pane, double-click RegisteredOwner.  
6. Under "Value data", type the name that you want, and then click 

OK/Exit.  

Change the Location of Special Folders 
1. Start/Run/Regedit  

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersio

n\Explorer\User Shell Folders.  
2. Note the current location of the folder you want to move, and then 

using explorer move the folder to the new location.  
3. Edit the value in the key above for the folder you moved to reflect 

the new directory location.  

4. Log off or restart Windows for the changes to take effect.  

Change the Message Shown on the Logon Box 
1. Start/Run/Regedit  

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\ 

2. CurrentVersion\Winlogon.  
3. Value Name: LogonPrompt,  

4. Data Type: REG_SZ (String Value).  
5. Create a new string value named 'LogonPrompt' and enter the text 

you want to display. The default message is: 'Enter a user name 
and password that is valid for this system.' This feature can be used 

in conjunction with the Legal Notice Dialog Box before Logon tweak.  
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Change Drive Name and Icon  
1. Start/Run/Regedit  

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVers

ion\ Explorer\DriveIcons.  
2. Value Name: Default,  

3. Data Type: REG_SZ (String Value).  
4. Within the main key above create a new sub-key with a single letter 

representing the drive letter of the drive to be modified. (e.g. 

[HKEY...\DriveIcons\D]) Within the drive letter key create another 
sub-key called "DefaultIcon" (e.g. 

[HKEY...\DriveIcons\D\DefaultIcon]) and set the "(Default)" value 
to equal the fully qualified name of the icon file. If the file contains 

more that one icon follow it with a comma and the zero-based index 
of the icon (e.g. "c:\icons\myicons.dll,4"). 

5. Create another sub-key within the drive letter key called 
"DefaultLabel" (e.g. [HKEY...\DriveIcons\D\DefaultLabel]) and set 

it's "(Default)" value to equal the label for the drive letter (e.g. "My 
ZIP Drive"). You may need to restart Windows for the change to 

take effect, or press F5 to refresh My Computer.  

Change the Display Color of Compressed Files and 
Folders  

1. Start/Run/Regedit  
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion

\ Explorer. 
2. Value Name: AltColor,  

3. Data Type: REG_BINARY (Binary Value),  
4. Value Data: 00 00 ff 00 (default).  

5. Create a new binary value, or modify the existing value, named 
"AltColor" and set it to equal the hexadecimal RGB color value for 

the files and folders. Restart Windows for the change to take effect.  

Note: The option to "Display compressed files and folders with 

alternate color" must be enabled in explorer.  

Change the Name of Recycle Bin  
1. Start/Run/Regedit  

HKEY_CLASSES_ROOT\CLSID\{645FF040-5081-101B-9F08-

00AA002F954E}\ShellFolder.  

2. Value Name: Attributes,  
3. Data Type: REG_BINARY (Binary Value),  

4. Value Data: (70 01 00 20=enable, 40 01 00 20=default).  
5. Set the value of "Attributes" in the appropriate key below to "70 01 

00 20", you will then be able to rename and/or delete any special 
folders by right-clicking them.  

Change the Name for My Computer 
1. Start/Run/Regedit  

HKEY_CLASSES_ROOT\CLSID\ {20D04FE0-3AEA-1069-A2D8-
08002B30309D}.  

2. Data Type: REG_EXPAND_SZ (Expanded String Value).  
3. Rename the value named "LocalizedString" to "LocalizedString.old".  

file:///c:/icons/myicons.dll,4
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4. Create a new REG_EXPAND_SZ value named "LocalizedString", and 

set the value to "%USERNAME% on %COMPUTERNAME%".  
5. Exit the registry editor, click on your desktop and press F5 (for 

refresh). The "My Computer" icon should now be renamed to 
"Username on Computername".  

Add Explore From Here to Every Folder  
1. Start/Run/Regedit  

HKEY_CLASSES_ROOT\Directory\shell\Explore.  
2. Value Name: (Default),  

3. Data Type: REG_SZ (String Value),  
4. Value Data: explorer.exe /e,/root,"%1"  

5. Change the value of '(Default)' to equal 'E&xplore From Here'.  
6. Create a new key under the [Explore] key called command, and edit 

the (Default) value to equal explorer.exe /e,/root,"%1".  

Display the Attributes Column in Explorer  
1. Start/Run/Regedit  

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion

\ Explorer\Advanced.  
2. Value Name: ShowAttribCol,  

3. Data Type: REG_DWORD (DWORD Value),  

4. Value Data: (0 = disable, 1 = enable).  
5. Create a new DWORD value called 'ShowAttribCol' and set the value 

to '1' to enable the attributes column.  

Clear Cached Command Lines from the Run Menu 
1. Start/Run/Regedit 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion

\Explorer\RunMRU.  
2. Delete the value corresponding to the command you want to 

remove, or remove all the entries to clear the list completely.  

SYSTEM & SYSTEM PERFORMANCE EDITS 

Unload DLL's 
1. Start/Run/Regedit  

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\ 
2. CurrentVersion\Explorer.  

3. Create a new sub-key named 'AlwaysUnloadDLL' and set the default 
value to equal '1' to disable Windows caching the DLL in memory. 

Restart Windows. 

Stop Error Messages When Booting  
1. Start/Run/Regedit  

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Windows.  

2. Value Name: NoPopupsOnBoot,  
3. Data Type: REG_DWORD (DWORD Value),  

4. Value Data: (1 = disable messages).  
5. Stops the annoying Windows pop-up messages notifying you a 

device is not functioning when you boot-up Windows.  
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6. Create a REG_DWORD value of 'NoPopupsOnBoot' in the key (if it 

doesn't already exist). Set the value to '1' to disable pop-up 
messages from appearing.  

Show Hidden Operating System Files 
1. Start/Run/Regedit 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\ 
2. Explorer\Advanced.  

3. Value Name: ShowSuperHidden,  
4. Data Type: REG_DWORD (DWORD Value),  

5. Value Data: (0 = Hide Files, 1 = Show Files).  
6. Create a new DWORD value, or modify the existing value, called 

'ShowSuperHidden' and edit the value according to the settings.  
7. Exit your registry, you may need to restart or log out of Windows 

for the change to take effect.  

Clear Pagefile on Shutdown 
1. Start/Run/Regedit 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\ 

2. Session Manager\Memory Management  
3. In the right pane, "ClearPageFileAtShutdown", modify, change value 

to 1.  

4. Exit the Registry and reboot.  

Automatically Close Non-Responding Applications  
1. Start/Run/Regedit  

HKEY_USERS\.DEFAULT\Control Panel\Desktop,  

2. Value Name: AutoEndTasks, Data Type: REG_SZ (String Value),  
3. Value Data: (0 = disabled, 1 = enabled).  

4. Modify the value of 'AutoEndTasks' to equal '1' to automatically end 
tasks or '0' to prompt for action.  

Automatic Window Refresh  
1. Start/Run/Regedit  

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Update.  
2. Value Name: UpdateMode,  

3. Data Type: REG_DWORD (DWORD Value),  
4. Value Data: default = 1.  

5. Create a new DWORD value, or modify the existing value, named 
"UpdateMode" and set it to equal "0" for faster updates. Restart 

Windows.   

INTERNET EXPLORER TWEAKS & EDITS  

Speed Up Browsing (Windows Explorer and IE) 
1. Start/Run/Regedit 

HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersio

n\Explorer\RemoteComputer\NameSpace  
2. In the left pane find Value: {D6277990-4C6A-11CF-8D87-

00AA0060F5BF}  
3. Delete it.  
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Configure Internet Downloads 
1. Start/Run/Regedit 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion

\Internet Settings.  
2. To increase the number of simultaneous connections that are 

allowed to 10, follow these steps:  

1. On the Edit menu, click Add Value 

2. Add the following registry values: 

"MaxConnectionsPer1_0Server"=Dword:0000000a 
"MaxConnectionsPerServer"=Dword:0000000a.  

Change default Download Directory  
1. Start/Run/Regedit  

HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer 
2. In the right pane, double click on the Download Directory value.  

3. Enter the path to the folder you want as your download location. 
4. Next, right click on the Internet Explorer subkey and select 

Permissions. Then click the Advanced button on the Security 
tab. In turn, Highlight Administrators, your user account and 

System. For each one, click the Edit button. In the Deny column, 
put the check mark in Set Value. Then click OK. Repeat for each of 

the remaining user accounts. Once done, click the Apply button on 
the Advanced Security Settings dialog. 

5. This removes the "permissions" for anything or anyone to write to 
the Download Directory value. It also prevents changes to any of 

the other values listed directly under the Internet Explorer sub-key, 

so you may wind up preventing something else from being changed 
as well. Unfortunately, it’s not possible to remove permissions from 

individual values.  

Using the Internet Explorer Classic Search 
If you want to use the classic search engine in the Internet Explorer, 
follow these steps: 

1. Start Regedit  
2. Go to HKEY_CURRENT_USER\Software\Microsoft\ 

Internet Explorer\Main  
3. If it is not there, create a String Value of Use Search Asst  

4. Give it a value of no  

Change the Search Assistant in Internet Explorer 
1. Start/Run/Regedit 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\ 

Search  
2. Value Name: SearchAssistant  

3. Data Type: REG_SZ (String Value)  
4. Value Data: Search URL  

5. Create a new String value, or modify the existing value, called 
'SearchAssistant' and edit the value according to the settings above.  

6. Exit your registry, you may need to restart or log out of Windows 

for the change to take effect.  
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Change the Default Internet Explorer Search Page  
1. Start/Run/Regedit  

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet 

Explorer\Main.  
2. Value Name: Search Bar,  

3. Data Type: REG_SZ (String Value),  
4. Value Data: Search URL.  

5. Create a new String value, or modify the existing value, called 

'Search Bar' and edit the value according to the settings below.  
6. Exit your registry, you may need to restart or log out of Windows 

for the change to take effect.  

Remembering Outlook Password 
On systems, Outlook or Outlook Express will not remember the e-mail 
password, which would then need to be entered in each time. To solve the 

problem, follow these steps: 

1. Open Regedit  

2. Go to HKEY_CURRENT_USER \ Software \ Microsoft  
3. Right Click Protected Storage System Provider  

4. Choose the Permissions option  
5. Click the Advanced box near the bottom right hand corner. This 

should open another box, towards the bottom of this box there 
should be two tick boxes, make sure that both of them are ticked. 

Click Apply, another box will open, click Yes, then OK twice. 
6. Left Click the + next to Protected Storage System Provider and 

Delete any sub folder in this tree. (Right clicking and choose the 

delete option or press the delete key and choosing yes to delete)  
7. Shutdown and Restart Computer.  

 

 
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SSOOMMEE  GGLLOOBBAALL  AABBBBRRIIVVIIAATTIIOONNSS  
 

e.g  example gratia   (For Example) 

et.al.  at alii     (and others) 

etc.  et cetera    (and so forth) 

i.e.  id est     (that is) 

LL.B.  Legum Baccalaureus  (Bachelor of Law) 

Ph.D. Phiosophiae Doctor  (Doctor of Philosophy) 

RSVP  répondez s’il vous plait  (please respond) 

viz.  Videlied    (namely) 

e.a  each 

TIP  To insure promptness 

ZIP  Zoning Improvement Program  
 


